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About LanSchool v7.2  
Thank you for purchasing LanSchool v7.2.  LanSchool v7.2 is an award winning 
software program designed to help teachers improve the learning environment in a 
computer-based classroom.   

 

With LanSchool installed on each computer in a classroom, a teacher has the ability 
to: 
 

Reduce Student Distractions 
A teacher can reduce student distractions by Blanking Screens, Limiting 
Applications, Limiting Web Browsing, Limiting USB drives or Disabling Printing on 
student computers. This helps direct student attention from their computer to the 
teacher and keeps students on task. 
 

Demonstrate Skills 
With the Show Teacher feature, students can watch what’s happening at the 
teacher’s computer, right from their own monitor.  This is ideal for presentations and 
showing students how to use computer applications. 
 

Monitor Students 
Ideal for monitoring student activity within a classroom setting, the Thumbnail feature 
allows you to view all or any particular student’s screen as well as quickly see at a 
glance the current application and website that the students are running. 
 

Assess Student Understanding 
Students can be quickly polled during a lecture or given a longer quiz or test.  
(Not available yet for the LanSchool Mac student software) 
 

 Help Individual Students 
Students can silently Request Help from the teacher.  A small question mark appears 
by their login name which indicates they need help.  At that point you can Chat with 
the student or Remotely Control their machine to help them with their question. 
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Supported Environments 
LanSchool v7.2 works with any combination of the following operating systems and 
thin client devices: 

Windows* 98, Windows ME, Windows 2000, Windows XP-32, Windows Vista-32, 
Windows 2003 Terminal Server, Citrix, NComputing, Mac OS 10.4 and 10.5. 

The only exception is the LanSchool Teacher console will not run on Mac operating 
systems unless you are running Windows through Parallels or VMWare.  A Mac 
console will be available Mid 2009. 

 
Listed below are the minimum requirements necessary to run LanSchool on both the 
teacher and student computers. 
 
Processor 
PCs:  166 MHz Intel® Pentium® processor or faster 

Macs: 700 MHz PowerPC G4, G5 or faster, Any Intel-based Mac 

 

 

RAM 
- 48 MB for Windows 98 

- 96 MB for Windows 2000 

- 128 MB for Windows XP 

- 256 MB for Windows Vista 

- 512 MB for Mac OS 10 

 

Protocol stack 
All computers running LanSchool must be configured with TCP/IP running static or 
dynamic IP addresses.  802.11 wireless is supported, however enterprise class 
access points are recommended. 
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Technical Support 
3 years of free technical support is included as part of the LanSchool product. You 
have three options for getting support:  

 

World Wide Web  
For the latest information about LanSchool, as well as FAQs, white papers, and 
much more, visit the Web site at http://www.lanschool.com. 

 

E-mail  
Send your questions via e-mail to support@lanschool.com. 

 

Phone 
Call Toll-Free (877) 370-5546 during business hours (U.S. Mountain Time).  

 

Our technical support policy is one of the best in the industry. If we cannot find and 
fix a LanSchool problem with a few phone calls or e-mails, we will fly a technician 
anywhere in North America (at our expense) to resolve the issue. This “on-site” 
support is even offered on the 30-day-demo version of the software. We stand 
behind the quality of our software! 
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Getting Started 
Your LanSchool v7.2 product download includes the executable file needed to install 
the LanSchool application, as well as electronic copies of this LanSchool 7.2 
Installation Guide (INSTALL.PDF) and the LanSchool 7.2 User’s Guide 
(USERS.PDF).  
 
Both guides are in Adobe Acrobat* .PDF file format and require Acrobat Reader* to 
view or print from. Acrobat Reader is available on your LanSchool product download 
in the Acrobat folder, or free off of the Adobe Web site at http://www.adobe.com. 
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Installation 
If LanSchool isn’t installed on your classroom computers, refer to the LanSchool 7.2 
Installation Guide (INSTALL.PDF). Once you’ve installed LanSchool, follow this 
guide to begin using the product.   
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How LanSchool Works  
LanSchool works by enabling a teacher to control all student computers within a 
computer-based classroom. 
 

It uses teacher “channels” to ensure that all the computers in that classroom see the 
same computer screen; much like a TV channel enables different TVs to see the 
same program. LanSchool has 16,000 teacher channels from which to choose, which 
means that you can have as many as 16,000 different classrooms using LanSchool 
at any given time. 
 

The most logical way to set up LanSchool is for each classroom or room to have its 
own teacher channel, as well as just one teacher computer. This setup enables all of 
the computers in the same classroom to interact with each other and one teacher to 
control the entire room. 

 
However, there is a version of LanSchool which will support One-to-One schools. 
(These are schools which have a personal computer for every student and teacher.) 
When the one-to-one version of LanSchool is installed the students have the ability 
to join or leave a channel. 
 

The teacher can monitor students as they join and/or leave the class. The teacher 
can also compare the current list of students in the class against a previously saved 
class list. This makes it easy to see who is absent or who has joined the class but 
really should not be there. 
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Using the Teacher computer  
The use model for LanSchool 7.2 is quite similar to previous versions. On the teacher 
computer, you will see a small LanSchool icon (that looks like a small green circle of 
circles) in the system tray. The system tray is located in the bottom right corner of 
your computer screen. You will use this menu to control the key features of 
LanSchool. 

 

More advanced features are available when you access the LanSchool Console.  
The console can be accessed by “left clicking” on the LanSchool system tray icon. 
 

In the console the key features are available as icons on the toolbar.  All of the 
features can be accessed through the menus.  It is also possible to right mouse click 
on computers or thumbnails to access the key features. 
 

When selecting computers or thumbnails we recommend using “ctrl-a” to select all 
computers or hold down the “ctrl’ key and click with your mouse to select a group 
of computers.  In the thumbnail view you can select multiple computers by just 
selecting them with the mouse. 
 

When using the toolbar buttons, a single click enables that feature and presses the 
button.  Another click will disable that feature. 
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About the Student computers  
LanSchool is set up to run in the background on student computers. All of the 
functionality is controlled at the teacher computer, which enables you to have control 
over how it is used.  
 

LanSchool Student Icon 
A LanSchool icon (green circle of circles) appears in the system tray at the bottom 
right corner of the computer screen. If you place your cursor over the icon, it will tell 
you which teacher channel this computer is using. 
 

If a student single clicks on this icon they can click it to request help from the teacher.  
The student can type a question and a small question mark is displayed in the 
console indicating that student has a question.  The question mark goes away when 
the teacher chats with the student or uses the menu Clear Student Question. 
 

If a student right clicks on this icon, it will bring up the student files folder where the 
Send/Collect files feature sends files. 
 

NOTE: If you installed the “One-to-One” version of LanSchool (this assumes a 
personal computer for EVERY student) the students will have a menu option to 
select which channel they wish to join. 
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User Interface Tips 
LanSchool was designed to be simple and easy to use.  Most of the features that you 
will use everyday are accessible from the LanSchool system tray menu.  Some of the 
more advanced features are available in the new LanSchool Console.  Notice that all 
of the critical features were grouped under one of five menu items:  Demonstrate, 
Monitor, Restrict, Administer, View 

 

Listed below are some tips about using the LanSchool Console. 

 

LanSchool Toolbar Buttons 

To use a feature in LanSchool, select the student or students and press the 
LanSchool Toolbar button that corresponds to the feature that you want to use.  At 
that point the button will depress and change to a lighter color.  To stop using that 
feature, click the button again. 
Some of the LanSchool Toolbar Buttons have a little arrow to the right of the button.  
Click on the button to access additional options for that feature. 

 

Activating Web and Application Limiting 

Web and Application limiting must be configured before they can be activated.  You 
may configure these features in the options menu and then turn them on through the 
menus or the toolbar. 

 

Note: Allowing or blocking specified websites is not supported on the Mac student.  If 
you select any of the web limiting options, ALL web browsing will be stopped on the 
Mac. 

 

Right-mouse click 

In the LanSchool console you can access advanced features by right-mouse clicking 
on a student computer in either the Detail or Thumbnail view. 

 

Multiple Select 

It is possible to select several (or all) students in this list.  
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To select multiple students, use the standard Windows “ctrl” click method. You can 
also select the entire list with the “ctrl-a” key sequence.   In the details view, the line 
will turn blue when selected.  When selected in the thumbnail view, the thumbnail will 
have a thick red line surrounding it.  In the thumbnail view can you select multiple 
thumbnails just by clicking on another thumbnail.   

 

Once you have selected the desired students, you can right-click on the selected 
students and get an advanced options menu, click on the toolbar button or console 
menu. 

 

Unselect Students 

To unselect students, click on a “blank” area of the console 
 
Implicit ALL Selection 
If no students are selected, there is an implied all selection when activating key 
features like Blank Screens or Show Teacher.  If no students are selected and you 
click the blank screens toolbar button, all of the student screens will be blanked. 
 
Refresh Screen 
Pressing F5 or the menu item View -> Refresh will refresh the console by initiating a 
discovery. 
 
Sorting 
By default, the detail view is sorted alphabetically by the “Login Name” column. If you 
click on the any of the other column headings, the list will sort on the selected 
column.  
 
LanSchool System Tray Menu 
A right mouse click on the LanSchool icon in the system tray menu will bring up a 
menu that contains the features that most teachers use every day.   
 
A left mouse click on the system tray icon will stop the action that you are doing to 
the students and bring up the new LanSchool Console. 
 

HotKey for the LanSchool Menu  

Some teacher machines do NOT have a visible task bar. Since it would not be 
possible to click on the non-visible icon, you can bring up the LanSchool Teacher’s 
menu with a <Ctrl><Alt> “L” hotkey. (the “L” stands for “LanSchool”) 
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Magnify Thumbnails 
The magnify menu on the View All button turns on or off the ability to hover over a 
thumbnail and have it expand temporarily to a larger size. 
 
Selected Only 
In thumbnail view you can just watch a few machines by selecting those machines 
and pressing the “Selected Only” menu beneath the arrow on the View All button. 
 
Classroom Layout 
Classroom Layout allows you to arrange the thumbnails in the shape of the 
classroom.  A classroom layout is automatically saved for each size of thumbnails.  
To switch to classroom layout view, click the arrow to the right of the View All button 
and select Classroom Layout. 
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LanSchool v7.2 New Feature Overview 
LanSchool v7.2 includes many new features but was designed to still be simple and 
easy-to-use.   
 

Here are the new features found in LanSchool v7.2: 

 
Mac Student Support 
The LanSchool student software will now run on Mac OS 10.4 and 10.5 and supports 
most of the features that are available on the Windows version.  The only features 
that are not currently supported are allowing/blocking specified websites, Voting and 
Testing. 

 
Thin Client Support 
LanSchool supports thin client, fat client and a mixture of both thin and fat clients.  
The following thin client environments are supported: Windows 2003 Terminal 
Server, Citrix and NComputing. 

 

Student Testing 
Teachers can create up to 100 question tests that can include graphics (.jpg, .png, 
.gif, .bmp).  The tests can then be sent out to one or more students and tracked in 
real-time.  Teachers can optionally time the test and export the results to a .csv file. 
(Not available for Mac students) 

 

Muting 
Teachers can mute the sound on student computers.  This can be done through the 
Mute button or through the Mute Student Speakers menu. 

  
Secure Mode 
LanSchool can be configured to require a password to access the console.  This 
password must match the password that entered during the secure student install. 

 
Blank Screen Enhancements 
The last 10 blank screens messages are saved and easily accessible through the 
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arrow to the right on the blank screens button.  When the blank screens message 
appears on the student computers, it is now sized to better fit the screen. 

 

Real-time Keystroke Monitoring 
When the keystroke monitoring window is open, it refreshes automatically and shows 
student keystrokes in real-time.  If you scroll back to view previous keystrokes the 
automatic refresh is disabled until you scroll back to the bottom of the list. 

 

Limit Task Manager (PC) or Activity Monitor (Mac) 
Check this option if you want to limit the student’s access to Task Manager or Activity 
Monitor 
.   
Toolbar Configuration 
The toolbar can be customized through the menu View -> Configure Toolbar.  It can 
also be configured by holding down the “alt” key while dragging the buttons to a new 
location or removing them by dragging them off the button bar.  You can also reset 
the toolbar back to the default in the Customize Toolbar window. 
 
If there are more buttons on the bar than you can see, they can be accessed through 
the “>>” chevron button on the upper right corner of the toolbar. 
 
Student Name from Active Directory 
LanSchool normally displays the Windows or Novell login name.  Now if the Student 
Display name is available in Active Directory, that Display name is displayed in the 
Login Name column. 
 

LanSchool Teacher Kiosk Mode 
 
The LanSchool Teacher Console can be run in a way to that it cannot be minimized 
or closed.  To run the LanSchool Teacher Console in Kiosk Mode refer to the 
Installation Manual install.pdf. 
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LanSchool v7.2 Feature Overview 
 

LanSchool v7.2 also includes the following features that were available in previous 
versions:  

 
Show Teacher’s Screen Full Screen or Windowed 
You can show the teacher’s screen to all students on the same teacher channel.   

 
You can select between a “full screen” or a “windowed” show mode. In Full Screen 
mode, the teacher’s screen will take over the entire student’s screen and lock-out the 
student’s mouse and keyboard. 
 
In Windowed mode, the teacher’s screen will appear in a window on the student’s 
machine. The students can then resize the window and work by following along with 
the teacher. 
 

When you show your computer screen to student computers, a sound is transmitted 
from your speakers. This sound lets students know that a LanSchool session is 
about to begin.  If you want to change this sound, replace c:\program 
files\lanschool\start.wav and stop.wav with your own sounds.  

 

View Thumbnail Mode (Monitoring) 
You can view up to 250 crisp high color student thumbnails at the same time. Every 
student’s screen will appear as a “thumbnail” in the LanSchool console.  There are 4 
sizes of thumbnails that can be sized automatically to the best fit.  You can choose to 
only view selected students by clicking on the View All button then checking the View 
Selected option. 

 
Classroom Layout 
Thumbnails can now be arranged in the shape of the classroom.  Each size 
thumbnail has its own layout that is automatically saved. 

 
Magnify Thumbnails 
When you hover over a thumbnail, the thumbnail size will quickly increase.  If you do 
not like this feature, it can be turned off by clicking on the View All button then 
removing the check from the Magnify option. 
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Active Application/Website Icon 
In the upper right hand corners of the thumbnail you have the option of seeing an 
icon of the active application and website. 

 

Remote Control 
You can “take control” of a selected student.  This means, you can remotely use the 
mouse and keyboard on the selected student’s computer.  With LanSchool, you can 
remote control a computer at the login prompt.  In order to send the ctrl-alt-del 
command to a computer during remote control, you may click on the Control 
button’s chevron -> Send ctrl-alt-del menu or the Monitor -> Send ctrl-alt del 
menu item. 
 

Limit Student Web Browsing  
You can temporarily disable all or selected student access to Internet Explorer, 
Netscape, Mozilla, Opera, and most other popular browsers 

In the options dialog, you may choose between blocking all web activity, allowing 
certain websites or blocking certain websites.  This feature must be configured in the 
Options dialog and then turned on by clicking the Limit Web button or menu item. 
 
The allow and block lists now recognize the wildcards “*” and “?”, making it easier to 
limit certain kinds of websites. 
 
While the Internet is disabled, an icon on both the teacher and the student computer 
will indicate that the web is disabled. 

 

Note: On the Mac, selecting any of the web limiting options blocks ALL web browsing 
on the student. 

 

Limit Student Applications  
You can temporarily disable all or selected student access to specified software 
applications.  This must be configured in the Options dialog and then turned on by 
clicking the Limit Apps button or menu. 

 

Disable Student Printers  
You can temporarily disable all or selected student printers. Once disabled, the 
students will not be able to print until you again enable printing. 
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USB Thumb Drive Limiting 
From the console you can limit the student’s ability to access a USB thumb drive.  
USB keyboards and mice will NOT be affected.  This feature is only supported on 
Macs and on Windows 2000 and above . 

 
Keystroke & Application Monitoring 
Monitor ALL applications & keystrokes that have been pressed on a computer by any 
user.  This feature will not capture keystrokes at the login prompt or password 
dialogs and is only supported on Mac and Windows 2000 and above. 
 
Blank Screens  
Enables you to blank-out all student screens on your channel and disable all student 
keyboards and mice. The message may be customized in the Options menu. This 
feature is useful when you want to lecture without the distraction of students playing 
with their computers.   

 
Student Voting 
Ask Yes/No or multiple choice questions from the LanSchool Console and view in 
real-time how many students have responded and how they responded. 
 
Note: This feature is not available on Macs. 

 
Show a Student’s Screen  
Sometimes you might want to send a student’s screen to all other students.  Simply 
select that student and click the Show Student button.  While the button is enabled, 
the student will have control of their machine and their screen will be shown to the 
rest of the students in the class. 

 

Anti-tampering controls 
LanSchool 7.2 does not allow a student to mischievously “unload” the software or 
disrupt the classroom by unplugging the network cable. 

 

File Send and Collect  
You can send files to student computers and then retrieve them back. 
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Send a message 
You can send a message to any or all students. This is often an effective way to get 
a distracted student back on-task.  

 

Student Question 
Students can click on the LanSchool icon and type a question to the teacher.  A 
question mark appears on their machine or thumbnail. In the Details view you can 
see the student question in the ‘Last Question’ column. In the Thumbnail view you 
can see the student question by moving the mouse over the thumbnail image which 
displays the question in a tooltip.  The question mark can then be cleared by the 
teacher through a chat session or a right click on the thumbnail. 

 

Text Chat 
Teachers can initiate a text-based chat session with a single student. 

 

One-to-One Enhancements 
There is now a special version of LanSchool which will support One-to-One schools. 
(These are schools which have a personal laptop computer for every student and 
teacher.) When the Setup_One2One.exe version of LanSchool is installed, the 
teacher can monitor students as they join and/or leave the class. The teacher can 
also compare the current list of students in the class against a previously saved 
student list. This makes it easy to see who is absent or who has joined the class but 
really should not be there. 

 

Shutdown, Logoff, Restart 
From the console, you can easily shutdown, logoff or restart student machines. 

 
Security status monitoring 
The LanSchool Security Monitoring tool can now be accessed by clicking View 
Status Window.  You no longer have to launch a separate application to find rogue 
teacher consoles.  This feature shows all LanSchool traffic so that you can identify 
unauthorized LanSchool activity. 
 
You may still launch the command line tool security.exe, found in the Utilities folder 
on the product download, to log all LanSchool activities to a file. 
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View Student's Running Applications 
You can view all running applications on a student's PC and add those applications 
to the allowed or blocked lists. 

 
Draw on screen 
Sometimes a teacher might want to underline, circle, or draw special attention to a 
part of the screen. This option allows you to draw with a “red pen” on the screen. 
Press the left mouse button and move the mouse to draw. To end this mode, close 
the “Draw on Screen” window by clicking on the X in the upper-right corner of the 
screen.  

 

Easy to see mouse cursor 
In order for the students to better see the teacher’s cursor, a large red cursor 
appears in the student view. These cursors are the same shape as the real cursor, 
but are 4 times the size and are bright red. 

 

Student Screen Snapshot  
If any student is misusing the computer, you can easily save that student’s screen to 
a standard graphic file. (.jpg or .bmp) by clicking on the Snapshot button.  The date, 
time and student login name are displayed in the saved file.  This file can easily be 
imported by most popular Windows applications such as Paint.  

 

NetWare Support  
If the computer is a using the NetWare client software, LanSchool 7.2 will use the 
NetWare login name instead of the Microsoft login name.  

 

Multicast support  
One of the benefits of using TCP/IP is the availability of Multicast. Multicast allows 
networking hardware to keep LanSchool traffic local to LanSchool computers and 
cross subnets. Because some network routers or switches don’t support Multicast, 
this option is disabled by default, but can easily be enabled.  
 
Student Power-Off  
You can log off, restart or power off all student computers. This can be a great time 
saver in a computer-classroom environment.  
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This feature might experience problems on Windows 9x machines. Microsoft states 
that this will not work on certain hardware. While it has been tested successfully on 
Compaq, Dell, and IBM computers, it may not be able to properly power down all 
brands or models of computers running the Windows 98, or ME operating system. 
(Please see Microsoft Knowledge Base Article Q220706.) 
 
Power on or Wake-On-LAN 

If your student computers are configured to take advantage of Wake-On-LAN 
technology, the LanSchool Teacher can “power-on” all student PC’s. This can be a 
great time saver in the mornings!  Most computers shipped with the Wake-On-LAN 
option turned off in the BIOS, so you must go into the BIOS setup at boot time and 
turn it on. 

 
Channel Grouping  
The teacher can group and control any specific channel and can now group any 
number of channels together and control all of these channels simultaneously. 

 

View Only  
This feature allows you to supervise a selected student machine. While supervising, 
you will see everything the student is doing, but will not be able to control that 
student’s keyboard and mouse. 

 

 
View All  
This will show all computer screens in the classroom as a small, medium, large or 
Extra Large thumbnails.  These views will be updated every few seconds.  
 

As you move your mouse over a thumbnail image, the student’s login name and 
computer name for that image appear in a tooltip. If the student has a question you 
will also see that question in the tooltip.  If you hover for about a second the 
thumbnail will get larger. If you right-click a thumbnail view, you will get a menu of 
options to control that student. 

  

Refresh List (F5) 
The list of students is a “static” list. By pressing this button, you can refresh the list 
and see any new students that might have entered the class. 
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Run Program 
This option allows you to run an application or a web site on student computers. This 
can be quite useful for younger students who have trouble navigating to a specific 
web address or starting a specific application. 

  

Handout or Collect Files to Selected Students  
This option allows you to distribute or collect files from student computers. The 
student must be logged in for this function to work.  

 

When collecting files, you specify the destination folder on the teacher’s machine. 
LanSchool will create a sub-folder there for each student’s file. The name of the sub-
folder will be [Student’s Login name]-[Student’s Machine Name]. This way you could 
collect a file from every student and still keep them straight on your machine.  

 

In its normal mode, the option to “Send Files to Students” is used to send one 
specific file to all selected students. However, there is one compelling case where it 
would be advantageous to send a different file to each student.  

 

Consider the following scenario:  

All students are working on a local typing application. This application stores the 
student’s currently completed work to a local data file in the “C:\LanSchool Files” 
folder. LanSchool can easily retrieve these files from all student machines and will 
save each file to a separate folder on the teacher’s machine. The folder name will 
always be in the form [login name]-[machine name]. (c:\My Documents\steve-
row3\data.dat”) 

 

It would be very useful if a teacher could replace these data files at the start of every 
class with the previous day’s class data.  LanSchool allows a “pseudo-folder” in the 
“Send Files to Students” dialog. The “pseudo-folder” is named “%STUDENT%”. 

 

If the local files were initially retrieved to “C:\My Documents\ClassSix” you could copy 
each student’s file back by specifying the file name “C:\My 
Documents\ClassSix\%STUDENT%\typing.dat. When LanSchool sees the 
%STUDENT% pseudo-folder it will replace that with the actual [login name]-[machine 
name] for the currently specified student. If multiple students are selected, the 
pseudo-folder will be expanded for each student.  
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Send Message  
You can be send messages to all or selected students. The message will appear in 
the lower, right-hand corner of the student’s machine. 

 

Show Internet History  
This shows all web sites visited by the currently selected student on the current day. 
It gets this history from the History Log of Internet Explorer. Because of this, it will 
NOT show the web history if the student is using a non-Internet Explorer 
browser, or if the student clears the Internet Explorer history log.  
 
On the Mac, Show Internet History will only work with the Safari web browser. 
 

Teacher can become a student machine from the menu 
If you want to turn the Teacher machine into a student machine temporarily, you can 
do it from the console.  Just click on Administer, then Become A Student Machine.  It 
will remain a student computer until it is rebooted. 

 
Remove Selected Students from Class 
This feature temporarily disables the LanSchool Software on the selected students’ 
machines. The software is Re-Enabled when a student next logs into that machine, 
or when you uses the “Add Selected Student Back into Class” option on that student 
machine. 
 
When a student’s machine has been disabled, it will still appear in the list, but will 
have a graphical stop sign on the computer screen. This is just a reminder to the 
teacher that this student is not controlled by LanSchool.  

  

Change Student Display Name  
This option does not really alter the student’s Windows machine name.  However, it 
will allow an alternative name to be displayed in the LanSchool’s Machine Name 
field. If your computers do not have meaningful Machine Names, you can use this 
option to better name the computers (i.e. “Row 1 Column 5”).  

 

Logoff, Restart or Power Off Selected Student Computers  
This option is useful at the end of the day when all computers need to be logged off, 
restarted or powered off. Instead of properly shutting down each and every computer 
individually, you can select all computers in the classroom and use this option to 
properly turn them off.   
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Student Question  
Students can type in a question to the teacher.  That question can be seen by the 
teacher by hovering the mouse over the thumbnail or looking at the Last Question 
column in the details view. 
 
Update LanSchool on Selected Students  
This option can be used to quickly install a new version of LanSchool Software on 
selected student machine.  To enable this feature, please refer to the Installation 
Guide for more information. 

 
Change Student Channel from the Console 

Teachers can change student channels from the console.  In previous versions, the 
only ways to change the channel were to re-install or run setchannel.exe.  This must 
be enabled by an administrator with the EnableChannelSelect utility. 
 
Options 
Enables you to configure how LanSchool works.  See the Configuration Options 
section below… 

 
NOTE:  The system administrator who set up LanSchool on your network most likely 
optimized these settings during installation. You may want to consult with that person 
before making any changes to the custom options.  
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LanSchool Security Monitoring 
With a tool as powerful as LanSchool, there’s always a possibility for misuse. A 
student may be tempted to find an unauthorized copy and load the teacher software 
to disrupt a class.  

There are two ways to deal with possible misuse.   

Set school policies around appropriate behavior, monitor and enforce the policy. 

Install LanSchool v7.2 in Secure mode, which requires a password. 

It is generally more effective and easier for schools to set policies about appropriate 
behavior in the training lab and set punishments for policy abuse. LanSchool helps 
facilitates the enforcement of your policy. Every time you broadcast, view, or blank-
out a student screen, as well as remove a student from the teacher channel list, an 
entry is made in the registry of the affected student computer.  

The entry is a “digital fingerprint” that tells what action was done, when it occurred, 
and who did it. If someone is suspected of misusing LanSchool, use the Windows 
utility REGEDIT to look at any student’s local registry and quickly identify the person.  

To use REGEDIT to view a LanSchool action 
At a student computer, click Start | Run.  

In the text box, type regedit. Click OK. A Registry Editor window will appear, 
with several folders.  

Look at the key HKEY_LOCAL_MACHINE\Software\LanSchool for 
information about any LanSchool actions that took place on this computer. 

Security Monitor is also available in the utilities folder on the LanSchool download 
image. This application runs on any machine and will capture a log of LanSchool 
activity, including the installation or un-installation of any LanSchool program. With 
this utility, many schools have quickly been able to pinpoint students who are 
abusing the “appropriate use policy” of their computer lab. There is a Security.pdf file 
in the same folder which describes this utility in detail.   

In LanSchool v7.2 you can also access the Security Monitoring data by clicking 
“View” then “Status Window”.  It is not necessary to start the command-line utility.  As 
soon as you perform actions you will see the security logging data. 

Students downloading and installing a demo version of LanSchool caused the largest 
security problem with the previous versions. Starting with LanSchool v6.1, the demo 
version cannot interact with the released version. It is doubtful that students will be 
interested in purchasing a full version, just to play a prank. However, if they do, the 
above-mentioned steps will allow you to quickly locate the offending students. 
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LanSchool Configuration Options 
The options dialog contains settings for both administrators and teachers.  Listed 
below are the settings that a teacher may want to change: 

 

Full Screen or Windowed 
Full screen shows the teacher’s screen on the student’s screen and disables the 
keyboard and mouse 

Windowed shows the teacher’s screen on the student’s screen in a re-sizeable 
window and does NOT disable the student’s keyboard and mouse. 

 

Blank Screen Message 
Allows the teacher to specify a message that will be shown when student screens 
are blanked. 
 

Web Limiting 
Specifies when Web Limiting is enabled whether to… 
Block all Web Browsing 
Allow only the following websites 
Block the following websites 
Save and Load website lists (.lsu files) 
 
Note: If any of these features are selected on a Mac, all web browsing will be 
disabled. 
 
Application Limiting 
Specifies when Application Limiting is enabled whether to… 
Allow only the following applications  
Block the following applications 
Save and Load application lists (.lsa files) 
Applications can be added to either the allowed or blocked lists by clicking on the 
add button in the options dialog or by Viewing the Student’s Running programs.  The 

Page 26 



LanSchool 7.2 Users Guide 

 

 

 

 

 

Page 27 

options dialog shows applications running on the Teacher’s PC. 

 
Student Thumbnail Size 
Allows the teacher to specify small, medium, large, extra large or “best fit” icon sizes 
when monitoring student computers. 
 

Show Current Application Icon on Thumbnails 
When enabled, this feature shows the current application that is running on the 
student PC as an icon in the upper left hand corner of the thumbnail. 
 

Show Last Visited Website Icon on Thumbnails 
When enabled, this feature shows the website that was last visited by the student as 
an icon in the upper right hand corner of the thumbnail. 
 
Full Path of the LanSchool Folder on Student Machines 
Allows the teacher to specify the default location for student files.  This can be on the 
hard drive or a network drive. 
 

NOTE: There are additional options, such as the network tab, that are described in 
the Installation manual and should only be changed by a system administrator. 
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